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DroneViewer 
  USER’S MANUAL      v1.2.5    18 July 2021 

 

Welcome to DroneViewer! 

DroneViewer is a Mac OS X and Windows application that displays your GPS-enabled 
GoPro and drone videos in a whole new way! With DroneViewer you can play your videos 
on the main screen while watching your drone’s speed, distance, position, and bearing 
update on graphs, data displays, and maps. You can geotag key points in your route and 
jump back to them instantly. You can export portions of your videos to separate clips, 
or export just a single geotagged frame. You can save your route to common file 
formats such as comma-separated value (CSV), GPS-exchange (GPX), or Google Earth 
(KML), for further data analysis. Read on to learn more of DroneViewer’s extensive 
capabilities.  

 

DroneViewer on the Mac showing player window, dashboard display, speed graph, map 
route, and control panel 
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FEATURES 

• Resizable main viewing screen. 
• Zoomable and translatable movie 
view. 
• Heads-up display of date, time, 
speed, distance, position, and 
bearing. 
• Geotag key points in your route, title 
them, and jump to these points 
instantly. 
• Save geotags to a text file. Import 
geotags back into DroneViewer. 
• See a listing of all movie files you 
load and hide files that are not of 
interest. 
• “Real time” display of UAV’s 
location, speed, and route on a 
Google/Mapquest Map. 
• Map pans automatically to keep 
drone centered, or you can keep map 
fixed. 
• Click on map route to jump to that 
position in movie. 
• Click on drone’s Graph trace to 
jump to that position in movie. 
• Graphical displays of speed, route 
distance, line-of-sight distance, 
bearing, altitude, and satellites-in-
view. 
• Auto-scaling of graph data. 
• Graph’s data traces are color-coded 
based on UAV’s speed. 
• Compass display of drone’s 
direction. 
• Weather display widget for retrieving 
weather conditions at the location and 
date of the currently-playing movie. 
• Automatic transition between 
sequential movie files. 
 

• Optionally skip the first n seconds of 
consecutive movies during playback. 
• Variable playback speed control. 
• Jump to fastest part of route, or to 
any loaded movie file instantly. 
• Slider controls for direct access to 
any movie file or any position in a 
movie file. 
• User-configurable instant replay 
button 
• Display of current movie file name, 
duration, frame rate, and file size. 
• Drag and drop loading of movie 
directories. 
• Export movie segments of user-
selectable duration and playback rate. 
• GPS data export to CSV, GPX, and 
KML file formats. 
• Export current movie window to PNG 
or JPG file. 
• Merge multiple sequential movies 
into a single large video at one of 7 
playback rates. 
• Support for per-movie display 
settings and graph units. 
• Click to reveal currently playing 
movie in the Finder/Explorer. 
• Support for meters/sec, km/h or 
mph speed units. 
• Support for timezone biasing to 
sync movies and data. 
• Keyboard and mouse shortcuts.  
• Controls for movie brightness and 
contrast (Windows version only). 
• Support for internet connection via 
proxy server.  
• Multiple language support: English, 
Chinese, more to come. 
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DRONE AND CAMERA COMPATIBILITY 

DroneViewer is compatible with the trajectory data produced by the following popular 
drones. In addition, it is compatible with the GPS data embedded in the GoPro HERO5 
Black, HERO6 Black, and likely the FUSION and HERO7 Black (untested at this time). 
Support for new models and data formats will expand as DroneViewer evolves. 

Drone Data Format 

 

Autel EVO 2     EVO       X-Star Premium 

Embedded Video Caption data in video file 
(EVO 2) 

ASS Video Caption file (EVO, X-Star 
Premium) 

 

    DJI Mavic Mini          DJI Mini 2 

Embedded Video Caption data in video file 

 

DJI Mavic Air 2      Pro             Mavic 2  

SRT Video Caption file 

 

DJI Matrice 200 

SRT Video Caption file 

 

DJI Phantom 4 Pro 

Embedded Video Caption data in video file 
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DJI Phantom 3      DJI Phantom 4 

SRT Video Caption file 

 

DJI Phantom 2 

FlyTrex Core 2 GPS logger & GoPro Hero 

 

GoPro HERO5, HERO6 

or HERO7 Black 

Embedded GPS data 

Any Drone GPX data file & video file 

 

Details for creating and working with ASS, SRT, GoPro, GPX, and FlyTrex log files are 
presented below.  
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SYSTEM REQUIREMENTS 

MAC VERSION 

• macOS 10.14 or later 
• Internet connection for Mapquest/Google Maps functionality 
• 1600x1200 or higher screen resolution recommended 

WINDOWS VERSION 

• Windows 10 recommended but DroneViewer may also work under Windows 7 
and 8 but these are not recommended.  

• K-Lite Codec Pack1. This pack includes codecs DroneViewer requires to play the 
various multimedia formats. 

• Intel i7 processor with nVidia or AMD graphics card recommended, although it 
may run on lower-end systems 

• 1600x1200 or higher screen resolution recommended 
• Internet connection for Mapquest/Google Maps functionality 

DIFFERENCES BETWEEN DRONEVIEWER AND DRONEVIEWER PRO 

The following table lists the differences between DroneViewer (trial version), 
DroneViewer, and DroneViewer Pro: 

Feature DroneViewer 
(trial version) 

DroneViewer 
(registered) 

DroneViewer Pro 

Maximum number 
of files that can be 
loaded at one time 

1 10 100 

Maximum number 
of Geotags 

2 10 100 

Max clip export 
duration (seconds) 

5 Unlimited Unlimited 

Max GoPro HERO5 
and HERO6 GPS 
track time per 
video 

30 seconds 1 hour 6 minutes 1 hour 6 minutes 

Licensing Personal Use 
Only 

Personal Use Only Commercial and 
Personal Use 

                                                
1 K-Lite Codec Pack URL is http://www.codecguide.com/download_k-lite_codec_pack_basic.htm 
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INSTALLATION GUIDE 

Installing DroneViewer takes just a few simple steps: 

INSTALLING DRONEVIEWER ON MACINTOSH 

1. Double-click on the .dmg file to mount the DroneViewer disk image in the 
Finder. You should now see the DroneViewer window in the Finder. 

 

The contents of the DroneViewer .dmg file after mounting in the Finder. 

2. Drag DroneViewer on to of the Applications folder shortcut. This will copy 
DroneViewer to your Applications Directory. 

3. Open your Applications directory and locate the DroneViewer icon. Do not 
double-click on the DroneViewer icon. Instead, right-click on the icon and select 
Open. 
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Open DroneViewer by right-clicking on its icon. 
 

4. If you are running macOS Catalina and you see a message indicating 
“DroneViewer can’t be opened because Apple cannot check it for malicious 
software”, go to your Security & Privacy system preferences and select Open 
Anyway.  

 

In macOS Catalina, select Open Anyway to run DroneViewer the first time. 

 
1. The first time you run DroneViewer, the macOS may display the “Verifying…” 

window for a minute or so. This is normal. Please be patient! 

 
The first time you run DroneViewer, macOS ‘verifies’ it. This may take a minute 

or so. 
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2. All done! The next time your run DroneViewer it should start-up immediately. To 

keep DroneViewer in the Dock, right-click its icon in the Dock and choose “Keep 
in Dock”. 

 

Right-click on the DroneViewer icon in the Dock to keep there.  

INSTALLING DRONEVIEWER ON WINDOWS 

1. After downloading, run the setup.exe installer. Follow the prompts to complete 
the installation. Upon completion you should see a DroneViewer icon on your 
Desktop.  

2. The first time you run DroneViewer, you will be prompted to install the K-Lite 
Codec Pack Basic. This is a free install that includes the codecs DroneViewer 
requires to play the various multimedia formats.  

 

Click on the “Download K-Lite Codec Pack” button to be directed to the Codec Guide 
website. 

3. Click on the ‘Mirror 1’ link to download the Pack and follow the installation 
instructions. 
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Click the Mirror 1 or Mirror 2 link to download the codec pack installer. 

4. Quit and re-run DroneViewer to take advantage of the codec pack. Click the 
“Don’t Show Me This Again” button to dismiss the reminder.  
 

QUICK START GUIDE 

 
1. Before you fly: if you’re using a DJI or Autel drone, go into the DJI Go App, DJI Fly 

App, or AutelExplorer App and turn on the Video Subtitles feature. Without this 
feature on, the drone will not store the drone’s trajectory data to an external file 
(SRT or ASS file) and DroneViewer won’t work properly. 

        

Be sure to enable Video Subtitles in your DJI Go, DJI Fly (left), or AutelExplorer app (right) 
before you fly. Also, use H.264 encoding for the video instead of H.265 or HEVC 
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2. If you drone offers the choice of H.264, H.265 (HEVC) video encoding always select 
H.264. H.265 is not supported on all platforms yet and may not play in 
DroneViewer. 
 

3. You are ready to fly!  
 

4. After your flight, run DroneViewer and load your drone or GoPro video files. For 
ASS, GPX, SRT and Flytrex CSV sources, DroneViewer will look in the movie file 
directory for GPS data. In order for DroneViewer to associate the movies with the 
correct data files, the data files must have the same base name as the movie files. 
For example, DroneViewer would expect to find the file DJI_0007.GPX, DJI_0007.SRT 
or DJI_0007.CSV if the movie DJI_0007.MP4 was loaded. You can load them in three 
ways: 
 

a. Select the Open Movie Folder… option from the menu or toolbar. Navigate to 
your SD card’s movie folder.  Click the Choose button.  

 
Choosing the movie folder on the Mac. On Windows, you would not see the movie 

files listed in the browser—you would only see folders listed. 
 

b. Drag and drop your SD card’s movie folder or individual movie files into a 
gray area of the DroneViewer’s main window.  

c. Select the Open Movie Files... from the menu or toolbar. Navigate to your 
movie folder and select the individual movie files you want to play. 

 
5. That’s it! DroneViewer will begin playing the first movie in the folder or in the list 

of movies that was selected. By default files are loaded according to file 
modification date (this can be changed to name ordering in the Preferences).  
When DroneViewer reaches the end of the movie it will jump to the next movie in 
the list and continue playing.  It will do this until all movies have been played.  
Keep reading to learn more about DroneViewer’s features and options. 
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DroneViewer running under Windows 10 

DETAILED START-UP GUIDE 

The following is a step-by-step guide for using DroneViewer. 

1. Before you start, make sure your drone or GoPro HERO’s internal clock is set to 
the correct time zone for your area.  DroneViewer relies on the file creation 
timestamps to sync the movie to the GPS data so this setting is important. If your 
camera’s time zone has not been set correctly or if you are viewing videos and 
GPS data from someone outside your time zone, the time bias can be 
compensated for.  See the Preferences and FAQ sections below on time zone 
biasing. 
  

2. On the Autel, Phantom 3, Phantom 4 series, and Mavic Pro series be sure that 
you have Video Captions turned on in the AutelExplorer, DJI Go App, or DJI Fly 
App. This feature makes the drone store trajectory data that DroneViewer needs. 
Also, be sure to record in H.264 video format. H.265 (HEVC) playback may not 
work on all computers with DroneViewer. 
 

3. For best performance, copy the contents of your drone’s SD card to your 
computer’s hard drive. Alternatively, if your Mac or PC has a built-in SD card 
slot, insert your SD card directly into your computer. As a fallback you can insert 
your drone’s SD card into a USB card reader attached to your Mac or PC, but this 
may result in video stuttering or poor performance if your USB bus is not fast 
enough.  

 

IMPORTING DRONE FLIGHT DATA FROM A DJI SRT FILES 
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If your DJI drone is controlled by the DJI Go 4 App (used to fly the Mavic Pro, Phantom 4) 
or the DJI Fly App (Mavi Air 2, Mavic Mini), then you can easily import your flight 
trajectory into DroneViewer. Before your flight, be sure you turn on the Video 
Caption option in the App’s camera settings. 

 

Turn on “Video Caption” in your DJI Go App or DJI Fly App settings to have your UAV 
create SRT files alongside your movie files. Note that the Mavic Mini and some Phantom 
4 Pro models do not create a separate SRT file. Instead, they embed the SRT data into 
the video file itself. 

This will make the drone create trajectory data for each video file. The SRT file contains 
the flight trajectory information. If you have a DJI Mavic Mini or Phantom 4 Pro v2.0, the 
SRT data is embedded in the movie file itself. If your DJI drone creates the SRT data in a 
separate file, make sure the SRT file is in the same directory as your movie and has the 
same root name.  

Drag one of your movies into the DroneViewer window or select Open Movie File from 
the File menu. DroneViewer will process the data and you’ll see your drone’s flight path 
and current position as the movie plays. The speed and number of satellites-in-view are 
also shown in the Graphs. 

A few caveats when working with SRT files: 

• If you rename the movie, be sure to rename the SRT file as well or else 
DroneViewer will not be able to find it. 

• The speed of the drone is computed based on waypoints. While it’s great that DJI 
conveniently logs the drone’s flight data into an SRT file, the speed of the drone 
is not recorded to the file and the latitude and longitude are not stored in high 
precision. DroneViewer uses the time-stamped lat/lon values to estimate the 
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speed. The lack of precision means the drone speed and direction can be 
inaccurate and appear to vary wildly. DroneViewer applies a smoothing function 
to dampen the speed variations. While this helps, it’s not a perfect solution. 
Ideally, DJI would modify their SRT file data to include native drone speed and 
higher-precision latitude and longitude. (There are other ways to extract the 
flight data to higher-precision but they are not as convenient as the SRT file 
method).  

• DJI continues to tweak Mavic 2 Pro SRT file format. The latest version of firmware 
as of this writing (v01.00.0200, DJI Go 4.3.8) contains latitude and longitude 
data and will work with DroneViewer. Unfortunately, no altitude data is provided. 
Hopefully this will change in subsequent firmware updates. SRT files produced 
by earlier firmware do not contain any latitude and longitude information and 
therefore will not work with DroneViewer. Please be sure you are running at least 
FW v01.00.0200 on your Mavic 2 Pro. UPDATE: Mavic 2 Pro firmware 
v01.00.0510 or higher now adds altitude data to the SRT file. 

IMPORTING DRONE FLIGHT DATA FROM AUTEL DRONES 

If your Autel drone is controlled by the AutelExplorer App then you can easily import 
your flight trajectory into DroneViewer. Before your flight, be sure you turn on 
the Subtitle .ass Files option in the AutelExplorer App camera settings. 

 

Turn on “Subtitle .ass Files” setting in your AutelExplorer App settings to have your UAV 
store flight trajectory data in the video itself (EVO 2) or in a separate ASS file (EVO, X-
Star Premium) 

On the EVO and X-Star Premium, this will make the drone create an ASS file for each 
movie. The ASS file contains the flight trajectory information. Make sure the ASS file is in 
the same directory as your movie and has the same root name.  

On the EVO 2, the flight trajectory data is embedded in the video itself so no separate 
ASS file is created. 

Drag one of your videos into the DroneViewer window or select Open Movie File from 
the File menu. DroneViewer will process the data and you’ll see your drone’s flight path 
and current position as the movie plays. The speed, distance, and altitude are also 
shown in the Graphs. 
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A few caveats when working with ASS files: 

• [EVO, X-Star Premium] If you rename the movie, be sure to rename the ASS file 
as well or else DroneViewer will not be able to find it. 

• The speed of the drone is computed based on waypoints. While it’s great that 
Autel conveniently logs the drone’s flight data into an ASS file, the speed of the 
drone is not recorded to the file and (as of EVO firmware 1.4.9) the latitude and 
longitude are not stored in high precision [EVO, X-Star Premium]. DroneViewer 
uses the time-stamped lat/lon values to estimate the speed. The lack of 
precision means the drone speed and direction can be inaccurate and appear to 
vary wildly. DroneViewer applies a smoothing function to dampen the speed 
variations. While this helps, it’s not a perfect solution. Ideally, Autel would 
modify their ASS file data to include native drone speed and higher-precision 
latitude and longitude.  

• Autel stores altitude relative to the standard WGS84 ellipsoid. Thus raw altitude 
values may appear as negative values even though the drone is above the earth’s 
surface. DroneViewer allows you to correct for this in a number of ways. For 
example, select the “Geoid” option in the Preferences to have DroneViewer 
convert the WGS84 altitude to Mean Sea Level altitude. You can also select the 
“relative to first point” option to have DroneViewer display the altitude relative to 
the first data point loaded. 

• [EVO, X-Star Premium] The ASS files produced by EVO firmware v1.4.9 (which say 
v4.00+ at the top of the file) contain syntatic errors in the longitude position. 
Autel has been notified of this error and hopefully it will be recitified soon. In the 
mean time, DroneViewer applies workaround for this bug so your drone’s stated 
location should be correct. When the longitude is eventually fixed, DroneViewer 
should work with the corrected format as well. 

IMPORTING GPS DATA FROM GPS-ENABLED GOPRO HERO CAMERAS  

To load the GPS data embedded in GoPro HERO5, HERO6, and HERO7 Black video files, 
simply select your file(s) from the File->Open menu or drag the files onto DroneViewer. 
The data will be located, processed, and displayed. Note that the HERO cameras store 
altitude data relative to the WGS84 ellipsoid. This is different than Mean Sea Level and 
can result in negative altitudes for activities that actually occur on the Earth’s surface. 
DroneViewer solves this problem by applying a Mean Sea Level (MSL) correction (know as 
a geoid undulation) to the HERO altitude data. If you do not want DroneViewer to apply 
the MSL correction, remove or rename the “egm96-15.pgm” located in DroneViewer’s  
“geoid” directory (Windows) or in the DroneViewer.app/Contents/Resources/geoid 
directory (Mac). 

The unregistered version of DroneViewer will display GPS data for the first 30 seconds of 
each video loaded. The registered and Pro versions will show GPS data for up to 66 
minutes of GPS track per movie. 
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GoPro HERO5 Black video showing embedded GPS trajectory data DroneViewer Pro. The 
airplane pilot used the GoPro to both videotape and track his flight. [Note: UTC 
timezone, not PDT] 

DroneViewer uses GPMF_Parser and GeographicLib, both under the MIT License. 

IMPORTING DRONE FLIGHT DATA FROM A GPX FILE 

GPX is an XML-based navigational data exchange format consisting of tracks and 
waypoints. An example of a very short GPX file is shown below. This sample has one 
track consisting of 2 waypoints: 

<?xml version="1.0" encoding="UTF-8" standalone="yes"?> 
<gpx xmlns="http://www.topografix.com/GPX/1/1" version="1.1" 
creator="DroneViewer Pro"> 
 <metadata> 
  <name>Produced by DroneViewer Pro version 1.2.2</name> 
 </metadata> 
 <trk> 
  <name>Track Start Time: 2019-09-21T16:45:35Z</name> 
  <trkseg> 
   <trkpt lat="44.6179330" lon="1.1762430"> 
    <ele>274.3</ele> 
    <time>2019-09-21T16:45:35Z</time> 
    <speed>0.0</speed> 
   </trkpt> 
   <trkpt lat="44.6179330" lon="1.1762430"> 
    <ele>274.2</ele> 
    <time>2019-09-21T16:45:36Z</time> 
    <speed>0.0</speed> 
   </trkpt> 
  </trkseg> 
 </trk> 
</gpx> 
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To load a GPX file into DroneViewer, you must give it a filename with the same base 
name as the movie it is associated with. For example, to load GPX data for a movie 
named DJI_0007.MOV, you must name the GPX file DJI_0007.GPX.  
 
If there is a timing synchronization difference between the movie and the GPX file, you 
can compensate for this by adjusting the Time Bias in the Preferences after loading the 
movie/GPX file.  
 

 
Enter a Time Bias to correct for video/GPX synchronization issues. 

 
An easier way to make the Time Bias adjustment is to use the “,” and “.” keys when the 
Graph window is selected. These keys will adjust the Time Bias by -1 or +1 seconds. For 
coarser adjustments, the “m” and “/” keys will move the Time Bias by -10 and +10 
seconds.  
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Adjust timeline using ‘m’, ‘,’, ‘.’, and ‘/’ keys when the Graph view is selected. Use keypoints in 

the video and map to help with precise alignment. 

When you are happy with the synchronization, click the Save Settings button, which 
looks like a disk icon in the Main window. The icon will turn green to indicate the 
settings, including the synchronization, have been saved.  
 

 
Saving the timeline settings 
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A settings file will be created in the same directory as the movie file. This file is 
automatically loaded every time you load this movie. If you’re not happy with the 
synchronization, click the disk icon again to delete the settings file. Then you can try 
again. 
 

IMPORTING DRONE FLIGHT DATA FROM A FLYTREX CORE 2 CSV FILE 

FlyTrex provides simple add-on logger that records your drone’s flight data to a 
microSD card. The Core 2 is compatible with many drones but I have only tested this 
method with the DJI Phantom 2. 

• After your flight, upload your FlyTrex Core 2 data file to the FlyTrex website. 
Click on the arrow at the top right of the mission and select Export Mission.
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• Choose the Download CSV option to export your flight data.

 

• Find the CSV file and drop it in the same folder as your flight movie. Rename the 
CSV file so it has the same base name as the movie file. For example, if your 
movie is called oil_pipeline.mov name the CSV file oil_pipeline.csv. 

• When you load the movie into DroneViewer the GPS flight data will be loaded as 
well. Unlike the SRT method, you will need to adjust the synchronization of the 
GPS log to the video. This is due to the difference in time between when the 
video recording started and when the GPS log started. To override DroneViewer’s 
automatic syncing feature, go into the Preferences and enter a Time Bias 
adjustment. 
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Adjust the Time Bias manually to adjust video/data synchronization. 

• Close the Preferences window and click on the Graph window. Now you can use 
the ‘m’ and ‘/’ keys to make coarse adjustments in the time-cursor position. 
Each click moves the cursor forward or  back 10 seconds relative to the video. 
Use the ‘,’ or ‘.’ keys for fine (1-second) adjustments. Look for key points in the 
movie, such as take-off or landing, to insure good synchronization. 

 

Adjust timeline using ‘m’, ‘,’, ‘.’, and ‘/’ keys when the Graph view is selected. Use keypoints in 
the video and map to help with precise alignment. 

• When you are happy with the synchronization, click the Save Settings button, 
which looks like a disk icon. 
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• The icon will turn green to indicate the settings, including the synchronization, 
have been saved. A settings file will be created in the same directory as the 
movie file. This file is automatically loaded every time you load this movie. If 
you’re not happy with the synchronization, click the disk icon again to delete the 
settings file. Then you can try again. 

 

 

FEATURES AND CONTROLS 

After loading a series of movies, there are a number of features you can use. Most 
features are common in both Mac and Windows versions, although a few features are 
available only in one or the other platform. 

MAIN VIEWER WINDOW 
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1. SELECT MOVIE FOLDER 

Click this button to load a new folder of movies into DroneViewer. 
Tip: You can drag a movie folder into the gray area of the window to load the movie 
folder.  
 

2. SELECT MOVIE FILES 

Use this button to load one or more individual movie files from a folder.  
Tip: You can drag a movie files into the gray area of the window to load them.  

3. EXPORT ALL GPS TRACK DATA TO CSV FILE 

Select this option to export all of the GPS track data to a comma-separated-value 
file. You can then load this file into Excel or a text editor for further examination. 
Details on this feature are discussed later in the manual. 
 

4. EXPORT GPS TRACK DATA TO GPX FILE(S) 
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Select this option to export your drone’s navigation data to GPX files. DroneViewer 
will export the entire route as a single GPX file. You will also have the option to 
export each movie’s individual GPS data to separate GPX files. The files will be 
named based on the movie names.  

 

Click Yes to create individual GPX files for each movie segment, as well as a 
large GPX file for the entire route. Click No to create just the large GPX file for 

the entire route. 

Since DroneViewer reads GPX files too, the single-file export feature can be used to 
load the GPS data back into DroneViewer. Since GPX files placed inside the movie 
directory are loaded ahead of the embedded GPS data in the movie, you can use this 
method to ‘override’ the GPS data for a given movie.  This allows you to filter out 
bad data or insert corrected GPS information into DroneViewer.  
 
GPX files are not just for use in DroneViewer. They are a formal data-exchange 
format and used by a number of software programs and websites2. 

5. EXPORT ALL GPS TRACK DATA TO GOOGLE EARTH KML FILE 

Select this option to export all of the track information to a Google Earth KML file. 
You can then load this file into Google Earth to see your UAV’s position over time. 

6. EXPORT VIEWER WINDOW TO JPG OR PNG IMAGE FILE ON DESKTOP 

Click this button to take a screenshot of the main window. The image file will be 
written to the desktop with the movie filename, latitude, longitude, and time-of-
movie embedded in the filename. For example, “DJI_0007.MOV_33.639860,-
117.973782@0m1.25s.png”.  
 
If you select JPG (in the Preferences), the latitude and longitude will be written into 
the EXIF block of the JPG.  

                                                
2 Example: http://gpsvisualizer.com 
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Your drone’s position is embedded in the EXIF section of the JPG image (Mac 

version). 
 
Image viewer applications that are EXIF-savvy, like Preview on the Mac, will 
automatically display the drone’s position in a map.  
 
Currently the EXIF feature is only available on the Mac version. 
 

7. EXPORT A PORTION OF THE CURRENT MOVIE TO A SEPARATE MOVIE 
FILE.  

Use this feature to export a fragment of a movie to a separate movie file. When you 
click this button you will be asked to enter the start time, duration, and/or stop 
time for the movie fragment. You will also have the option to exclude the audio 
track and change the playback rate. Slowing-down the playback rate will produce a 
slow-motion effect useful for isolating short events, like a collision. Important: 
When experimenting with playback rate, be sure to use the GPL version of ffmpeg. 
DroneViewer ships with the LGPL version. The GPL version has a much better 
default encoder and will produce superior video quality. The process for obtaining 
and installing the GPL version is listed in the FAQ section.  
 
By default, the start time is the current point in the movie. You cannot extend the 
duration beyond the end of the current clip. Note that the GPS data will not be 
preserved. 
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After clicking the Export Movie button you enter the start time and duration for the 

new movie. 
 
Note that the trial version of DroneViewer is limited to no more than 5-second 
clips. 

8. MERGE MULTIPLE MOVIES INTO A SINGLE LARGE VIDEO 

By clicking the Merge button you can combine multiple movies into a single large 
movie file. In addition, DroneViewer will create a GPX file containing the GPS data 
from the selected movies. Since the GPX file will have the same base name as the 
combined movie file, you can load the movie file back into DroneViewer and the 
GPX file will be detected and loaded as well. This can be useful for consolidating or 
organizing routes. 
 
Additional options include the removal of the audio track and adjustment of the 
playback rate. If you choose a playback rate other than 1x, DroneViewer will create 
a second combination movie that plays back at the desired rate. Choosing 
accelerated playback rates is useful for condensing long flights into short vignettes. 
Important: When experimenting with playback rate, be sure to use the GPL version 
of ffmpeg. DroneViewer ships with the LGPL version. The GPL version has a much 
better default encoder and will produce superior video quality. The process for 
obtaining and installing the GPL version is listed in the FAQ section. 
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Merge Movies window 

 
Select the first movie and the last movie. Only movies that are enabled in the 
Control Center Window will be available for merging. Movies that are disabled will 
not be a part of the merged movie, nor will their GPS data be exported. 
 
Click the Merge Movies… button and enter the destination for the combined 
movie.  
 
DroneViewer will use ffmpeg to combine all the movies between your first and last 
selections into a single large movie. There will be no loss in video quality so make 
sure your movie destination has enough space to hold the entire merged video. 
Also, make sure there are no quotes or commas in the source movie files’ path. 
Upon completion the following window will appear:  
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All done! 

Click Yes to go see your movie file and GPX file. Note that in the free version of 
DroneViewer does not support merging movies.  

9. SYNC WINDOW MOVEMENT 

If this option is toggled ON, all the windows will move together if any one of them 
is moved. If the option is OFF, then the windows can be repositioned independently. 
The idea is to first positions the windows independently the way you like, then 
“lock” them into position by toggling this option on. 

10. RE-CENTER MOVIE(S) 

This option re-centers the movie in the window. This is useful if you had previously 
zoomed or panned the movie and now want to return to the nominal state.  
Tip: On the PC version, clicking this button may clear the “black screen” issue seen 
sometimes when animation is paused.  

11. MODIFY PREFERENCES 

This toolbar button opens the Preferences window. See the section on the 
Preferences Window for more details. 

12. CURRENT SPEED 

The current drone speed is displayed in the top-center of the Main Window. The 
units of speed can be changed in the Preferences. 

13. CURRENT DATE/TIME 

The date and time are shown in the top-left of the Main Window. DV uses the 
modification date of the movie to determine the time since GPS data may not be 
available at all times.  Sometimes the modification date/time of a movie can change 
if the file is copied. Use the Clock Bias setting to compensate for this. 

14. MAIN WINDOW 

The Main Window displays the drone movies in sequence. You can translate and 
zoom the movie while it is playing as shown below. 
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Use the mouse to translate and zoom into the movie. 

 
• Zoom in/out of the movie using the mouse wheel (or “q” and “e” keys).  
• Pan the movie by click-dragging it in the Main Window. 
• Re-center toolbar button to reset the zoom/translation settings 

15. CURRENT MOVIE SCRUBBER 

This slider bar is used to scrub through the currently playing movie. The graphs, 
map, and dashboard displays dynamically update as the movie is scrubbed. 
 

16. MOVIE FILE SELECTOR 

This slider allows you to jump to a specific movie in the sequence. 

17. JUMP TO PULLDOWN MENU 

Use this menu to instantly jump to a specific movie, or to jump to the fastest point 
in the movie sequence. The list shows the movie filename, start date, and duration. 

18. REVEAL BUTTON 

Click this button to reveal the current movie file in the Finder (Mac) or Explorer 
(Windows). 

19. CURRENT MOVIE FILENAME, FILE SIZE, AND FRAME RATE 

This box displays the current movie filename, file size, dimensions, and frame rate. 

20. SAVE OR DELETE SETTINGS 

This feature was specifically designed for situations where the camera and GPS data 
logger are separate units, like a GoPro Hero/Flytrex Core 2 combo (this feature is 
also useful when using a GPX file as a trajectory data source). In these cases, the 
adjustments you make to the clock settings to synchronize the GPS data and the 
movie action are preserved to a file and automatically restored when the movie is 
reloaded. 

SAVE SETTINGS FEATURE EXPLAINED IN DETAIL: 
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If the Save Settings button is clicked, then whenever this movie is played the 
settings that were saved will be recalled and used. This is useful when playing a 
deck of movies that have widely varying speed ranges, altitude ranges, or time 
offsets and the user would like to sync and customize playback for each movie 
independently.  
 
For example, when using DroneViewer to playback GoPro videos captured with a 
Phantom 2 and Flytrex Core GPS logger, the sync between the movie start and the 
GPS start will vary depending on when the pilot turned on the Phantom and GoPro. 
By using the m , . / keys (see Shortcuts), the timezone offset can be changed 
interactively so the Graph’s time cursor position matches exactly what’s playing in 
the movie viewer.  Clicking the Save Settings will preserve this time offset so it need 
not be entered manually every time the movie is played.  
 
Settings remain in effect until the next settings file is detected. You can specify 
default settings for movies that do not have specific a settings file. To do this run 
DroneViewer (but do not load any movies), adjust your settings via the Preferences 
or shortcuts, and then click the blue disk icon button (“Save Default Settings”).  
 
If the “Save Settings” disk icon is green, then a settings file for this movie has been 
detected and is being used. If the “Save Settings” disk icon is blue, then there are no 
specific settings for this movie. In that case the current settings will be used unless 
a default settings file was created. Note that if using the Settings feature to adjust 
movie syncing with GPS data, you should deselect the Auto Fix Timezone Offset 
checkbox in the Preferences window before saving the settings. Failure to do so will 
make DroneViewer ignore your custom timezone offset values, which are used for 
movie/GPS syncing. To delete a settings file simply click the green disk icon one 
more time. 
 
Note: The Settings feature is an advanced capability and will generally not be 
necessary for SRT files. This is because SRT data files are automatically 
synchronized to the movie file. 

21. PLAY PREVIOUS MOVIE 

Use these buttons to jump back 1 movie in the sequence. 

22. INSTANT REPLAY 

Click this button to quickly replay the last few seconds of the movie. This is useful 
to review key events, such as a collision. The replay time can be set in the 
Preferences. 

23. PLAY/PAUSE MOVIE 

Toggle the play/pause button to start/stop the movie(s). 

24. INCREASE/DECREASE PLAYBACK RATE 
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Increase or decrease the movie playback rate. On the Mac version, playback rates 
from ¼x to 5x are supported. On the Windows version, playback rates of 1/16x to 
5x are supported. Note that some stuttering may occur if the playback rate is too 
fast for the computer. 

25. PLAY NEXT MOVIE 

Use these buttons to jump ahead 1 movie in the sequence. 

26. CREATE GEOTAG 

Clicking this button adds a new Geotag to the Control Center Window Geotag list. A 
Geotag is a bookmark that allows you to quickly jump to a particular point in the 
movie sequence. Geotags are shown as numbered markers in the Map Window. You 
can double-click on a Geotag within the Geotag list to instantly jump to that 
particular time in the movie sequence. The free version of DroneViewer is limited to 
creating 2 Geotags. See the section on the Control Center Window for more 
information. 
 

27. VOLUME AND MUTE CONTROLS (WINDOWS VERSION HAS ADDITIONAL 
COLOR CONTROLS) 

Click the speaker to mute the volume, or adjust the slider to change the volume. On 
the Windows version there are additional controls to adjust the brightness, and 
contrast.  

CONTROL CENTER WINDOW 

The Control Center provides instant access to your movies and geotags. The features 
and capabilities of each list are explained below. 

MOVIES  

The Movies list populates itself immediately after loading a series of drone movies. Each 
movie is analyzed upon loading and summary information for each movie is displayed. 
This information includes the filename, movie duration, file size, file start date, and 
maximum drone speed. The currently playing movie has a green background. Movies 
can be started by double-clicking a movie list item. 
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The Control Center’s Movie List. In the list above, movies #1 and #7 are inactive and the 
currently playing movie is #4. 

A wrench  icon to the right of the filename indicates that post-processing was 
performed on the movie’s GPS data due to some problem with the data. Hover the 
mouse over the wrench icon to learn more information about the type of problem 
encountered. The possible problems encountered are: 

1) Bad GPS position detected. At least one point has lat/lon of 0,0 deg. 
2) Bad GPS time value detected in at least one point. Applying a fix. 
3) At least one point has a speed value out of range. Applying a fix. 
4) Found fewer GPS points than expected for this movie. Attempting workaround. 
5) Some GPS data points out of chronological order. Applying a fix. 

DroneViewer does its best to patch the problem but you may still notice data issues with 
these particular files.  

The checkered flag  is displayed to the right of the movie filename having the fastest 
speed in the series.  
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You can remove a movie from the series by clicking off its checkbox. When you do this, 
its background will turn grey, it will not be double-clickable, its data will be removed 
from the Map and Graphs, and, if it was the high-speed movie, the checkered flag will 
find a new home. Click the Hide button to remove these inactive movies from the list. 
Click the Show button to bring these items back. The Invert button inverts the selection 
of inactive and active movies. 

Features of the Movies list are itemized below: 

1. MOVIES LIST.  

Click this tag to toggle between the Movies and Geotags lists 

2. HIDE/SHOW BUTTON 

Clicking the Hide button will remove the inactive movies from the list. Click it again 
to reveal the inactive movies. 

3. INVERT BUTTON 

Invert will make the inactive movies active, and the active movies inactive.  

4. MOVIE COUNT AND DURATION 

The information line shows the number of active movies and their total duration. 

5. MOVIE INFORMATION 

Each item in the list shows the movie filename, movie duration, file size, file date, 
and maximum UAV speed. Note that the file date is retrieved from the file system so 
if the file was modified in any way the date displayed here may not correspond to 
the actual date/time of the recording. 

6. CURRENTLY-PLAYING MOVIE 

The currently playing movie has a green background. Double-click on any active 
(non-gray) movie to make it the currently playing movie. 

7. CHECKERED FLAG 

The checkered flag is awarded to the movie with the fastest speeds. Sorry, no prizes 
are given. 

8. WRENCH ICON 

The wrench icon appears next to movies whose GPS data needed some kind of post-
processing. Hover the mouse on top of the icon to see a short explanation. Possible 
reasons for seeing the wrench icon include: 

1) Bad GPS position detected. At least one point has lat/lon of 0,0 deg. 
2) Bad GPS time value detected in at least one point. Applying a fix. 
3) At least one point has a speed value out of range. Applying a fix. 
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4) Found fewer GPS points than expected for this movie. Attempting workaround. 
5) Some GPS data points out of chronological order. Applying a fix. 

9. ACTIVE/INACTIVE CHECKBOX 

Clicking the checkbox off makes the movie inactive. Inactive movies are removed 
from the playback sequence and are shown with a gray background in the list. Their 
GPS data are also removed from the Map route and Graphs. Use this feature to 
remove uninteresting movies from the playback sequence. Click the checkbox on to 
make the movie active again. 

10. DOUBLE-CLICK MOVIE ITEM 

You can double-click an active movie item in the list to jump to it. If playback was 
previously on, the movie will start playing immediately. 
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GEOTAGS  

Geotags are key points in the movie sequence that you can highlight and return to 
instantly. They can represent important points in your sortie, such as the location of a 
well, a pipeline leak, or stranded hiker.  Of course these are just examples. The use for 
geotags is limited only by your imagination. 

To create a geotag you simply click the  icon in the Main Window at the point of 
interest. Alternatively you can tap the ‘g’ key on the keyboard. This will add an item to 
the Geotag list. A marker will also be added to the Map. For reference, the movie name, 
date/time, speed, location, and movie time will be shown in the list item.  

 

 

 

(Left) Geotag list, (Right) Geotags in the Map window. Note: Geotag names are fictional. 

Double-click on a geotag in the list to jump to that point in the movie sequence. You 
can give each geotag a custom title by clicking on the gear  icon. To delete a geotag, 
click the trashcan  icon. To delete all the geotags in the list, click the Clear All button. 

You can export your geotag data to a tab-delimited text file for external processing in 
Excel or another program. To do this, click the Export button and a .text file will be 
produced. You can also load the geotag .text file back into DroneViewer to see your 
saved geotags. When exporting, it is important to save the geotag file to the same 
directory as the movie files if you want to reload it later. Be sure to load the movies 
first before loading the geotag file. Geotags that refer to a movie that is not loaded will 
have a gray background and will not be selectable.  
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You can create two geotags with the free (unregistered) version of DroneViewer, up to 
10 with the paid version, and 100 with the Pro version.  

The Geotag functions are itemized below: 

 

Geotags List. Note: these are fictional ID tags. 

1. GEOTAGS LIST 

Click this tag to toggle between the Movies and Geotags lists. 

2. IMPORT BUTTON 

Click this button to load a geotag file back into DroneViewer. Be sure to load your 
movies that are referenced by the geotag file first, then load the geotag file. If the 
geotag file references movies that are not loaded they will appear in the list with a 
gray background. 

3. EXPORT BUTTON 

Export the geotags to a tab-delimited file. If you plan to import these geotags back 
into DroneViewer be sure to save the geotags file to the same directory as your 
drone movies. 

4. CLEAR ALL BUTTON 

The Clear All button will delete all geotags in the list. 
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5. GEOTAG INFORMATION 

The geotag list item displays meta information about the event including title, movie 
filename, time in movie, drone speed, date/time, and latitude and longitude. 

In addition, the meta information includes two “live” distance measurements. The 
first is the Line-Of-Sight (LOS) distance magnitude from the geotag to the current 
position of the drone. This distance includes the altitude difference, if altitude data 
is available. The Route distance is the distance to from the geotag to the drone’s 
current position as measured along the route line. 

 

 

Line-of-Sight (LOS) and Route distances explained 

LOS distance is useful for UAV operators to determine the range of the aircraft to the 
pilot. 

6. CHANGE TITLE 

You can edit the default title of a geotag by clicking the gear icon. 

7. DELETE GEOTAG 

Delete a geotag by clicking the trashcan icon. 

8. GO TO A GEOTAG 

Double-click a geotag to jump to that point in the movie sequence. 
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MAP WINDOW 

 

Google hybrid map showing drone position, speed, route, and geotags 

The Map view displays the time-history of drone’s route as well as its current position. 
The Route line and movie start Markers can be individually toggled on or off in the view 
using the checkboxes at the top of the window.  

Selecting the Follow checkbox will automatically pan the map to follow the drone. 
Unselecting this checkbox will freeze the map and the placemark point will move with 
the drone. 

When the Click To Go button is checked, clicking on the map near drone’s route line will 
make DroneViewer jump to that time in the movie sequence. This way you can quickly 
jump to any point in the movie sequence by simply clicking your position on the map. 
Deselect the Click To Go button to disable this feature.  
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The N Up button controls whether the map is oriented in the North Up direction (the 
default) or is oriented dynamically based on the drone’s direction. This feature only 
applies to Google Maps and only for certain regions that have high-resolution 3D 
imagery available. Regular “road” maps and “satellite” maps don’t support rotation. 
Zoom-in deep to see if “3D imagery” mode appears for your region. 

The Map window can be shrunk to a small size. If the window width is smaller than the 
minimum size for the control bar, then the controls will hide themselves. You can access 
the controls by simply increasing the width of the map. 

 

Small map with controls hidden. 

The UAV’s speed throughout its journey is reflected in the color of the route line. Faster 
speeds are bluish and slower speeds are reddish. The color scale can be adjusted in the 
Map Preferences (see above). 

 

Map preferences for the route color scale 

Choices include the number of colors in the scale and whether the maximum speed of 
the scale is based on a fixed speed or the fastest speed in the movie sequence. 
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Standard Map controls apply (zoom in/out, switch from map to satellite layers). You can 
choose between Google and Mapquest map APIs. If you change the map type, please 
reload your movie files to refresh the routes and markers. 
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GRAPHICAL DATA DISPLAYS 

Tip: You can click in the Graph view to jump to a specific time in the movie sequence 
(on the Windows version, two clicks are required) 

 

 

The Speed graph displays the 
combined time-history of the 
drone’s speed over all of the 
data in the movie folder. 

 

 

The Distance graph displays 
the distance covered by 
integrating the drones speed 
over time. The color-coding 
indicates drone speed at the 
time. 

 

The LOS graph displays the 
line-of-sight distance of the 
drone from the start point. 
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The Bearing graph shows the 
history of direction for the 
drone.  North is 0 or 360-deg, 
East is 90-deg, South is 180-
deg, and West is 270-deg.  

 

 

 

The Altitude graph 
displays the height of the 

drone above its home 
point. 

 

 

The Sats In View graph shows the 
time history of available 

GPS/GLONASS satellites in used to 
make the geolocation “fix”.  In 
general, the more satellites in 
view the better the fix (and lower 

the HDOP).  GNSS satellites are 
constantly in motion so the 9 
satellites in view now may be a 
different 9 in an hour or so.  

Terrain and urban canyons will 
block visibility to the weak GNSS 
signals and worsen geolocation 
accuracy.  
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The data in the Speed, Distance, LOS, Altitude, and Sats in View graphs can be 
automatically scaled by clicking the Autoscale button in the top left of the graph. You 
can click in the graphs to jump to that time in the movie sequence (two clicks are 
required in the Windows version). 
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DASHBOARD WINDOW 

The Dashboard displays current information about the drone’s position, speed, bearing, 
and distance. In addition, the Dashboard can be used to switch speed units, lat/lon 
format, show the weather at the time and place of the flight, and show the flying day on 
a calendar. 

 

1.  Computed speed, total elapsed distance, current date/time, mph-km/h-
meters/sec toggle 

2.  Current UAV direction (bearing). Click the arrows to change this widget to weather 
or calendar views. Tap the ‘f’ key on the keyboard to switch between quadcopter 
icon or arrow icon in the compass. 

If the “Get Weather” button is clicked, DV will attempt to retrieve the historical 
weather conditions at the UAV’s latitude/longitude (#3) for the given date displayed 
(#1).  DV uses http://darksky.net for the weather data. 

3. Current drone position (latitude/longitude).  Also, the drone altitude and number 
of GNSS satellites used in geolocation. 

Note that bearing is only updated when drone speed is greater than 3 mph (or km/h) to 
avoid jitter. 
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Use the Window menu to orient the Dashboard horizontally or vertically. 

Don’t like the horizontal orientation of the Dashboard? You can orient the Dashboard 
vertically by choosing “Vertical” from the Windows menu.  

You can reduce the width of the Dashboard widget until only the speedometer is shown. 
This minimalist size may be preferable for small displays. 

 

Dashboard resized to only show the speedometer. 

To change speed units, click once in the speedometer. 

To change the behavior of the speedometer, double-click on it. This will bring up the 
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Advanced Preferences where you can have the Speedometer automatically or manually 
scale to a maximum value 

 

Double-click on the Speedometer to adjust scaling behavior. 

To change the latitude and longitude format, click once in the lat/lon display or double-
click in the display to jump to the units selection in the Preferences. The options are 
Decimal degrees, integer degrees+decimal minutes, or integer degrees+integer 
minutes+decimal seconds. 

 

Click once in the lat/lon display to toggle through the various formats 
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PREFERENCES WINDOW 

 

The Preferences window 

TIME PREFERENCES: 

• Clock Bias – bias used to synchronize the embedded movie timestamp with the 
displayed time. Use this setting to match the embedded movie timestamp to the 
timestamp displayed by DV.  This setting does not affect the time biasing 
between the movie and the GPS data.  For that, use the Time Bias. 

• Time Bias – bias, in seconds, used to synchronize the GPS data and the video. This 
is useful if the drone video is out-of-sync with the Map, or the timezone is 
incorrectly set for your timezone, or if you are viewing movies creating by 
someone in a different timezone. 
Tip: If the Graph view is selected, you can use the “,” and “.” keys to adjust the 
Time Offset plus or minus 1-second. Similarly, you can use the “m” or “/” keys to 
adjust the Time Offset by 10-seconds. 

• Skip Time – this setting tells DroneViewer to skip the first n seconds of each movie 
during playback. This is useful if your drone has a built-in overlap of a second or 
so between consecutive movies. Enter the overlap time for (near) seamless 
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playback between consecutive movies. 

• Replay Time – enter the amount seconds that the Instant Replay feature goes back 
in time. 

UNITS PREFERENCES: 

• Speed Units – select the units for the speed and distance displays. 

• Lat/Lon Units – select the units for the latitude and longitude outputs. You can 
choose decimal Degrees, integer Degrees+decimal Minutes, or integer 
Degrees+integer Minutes+decimal Seconds. This setting affects the Dashboard 
GUI, the Geotags, and the CSV export functions. 

• Altitude Units – select the units for the altitude graph and data display. 

• Temperature Units – select the desired units for the temperature display in the 
historical weather widget. 

GENERAL PREFERENCES: 

• Movie Sequencing - This setting controls the play order of the movies. “By Date” is 
a better option for drone’s that write movie files in a continuous loop (i.e, new 
files overwrite older files as the SD card fills up). “By Name” is a better option for 
viewing a series of miscellaneous movies in a folder.  

• Aspect Ratio – You can choose to have the movie fill the viewer window or 
maintain its native aspect ratio.  In the latter case you will see black bars filling 
the unused space. 

• Screenshot – Chose the desired image type for screenshots (invoked from toolbar 
in Main window). PNGs are lossless but take up about 8x the disk space. To the 
naked eye, JPG is almost identical to PNG and much smaller file size.  On the 
Mac, the GPS coordinates of the drone are saved to the EXIF block of the JPG file. 

• Altitude Bias – Altitude is an interesting metric. Some drone manufacturers, like 
Autel and GoPro, provide altitude values that are relative to the WGS84 ellipsoid. 
Other drones, like the DJI Mavic Pro, provide barometric altitude relative to 
ground. And some drones don’t write any altitude at all. The altitude bias setting 
in DroneViewer allows you to convert the raw altitude values to the altitude form 
you prefer. For example, the Geoid setting biases the raw altitude values by an 
undulation value which is approximately the difference between WGS84 and 
Mean Sea Level (MSL). Therefore, this setting is preferred for the GoPro or Autel 
when MSL altitude values are desired. If Above Ground Level (AGL) altitudes are 
desired for the GoPro or Autel, select the Point 1 Relative setting. This setting 
subtracts the altitude of the first point loaded from all other points. Thus the 



 50 

start altitude becomes 0. For the DJI Mavic Pro, which is already producing 
altitude natively in AGL, you would select the None bias. You can further fine-
tune the altitude bias by manually entering a value in the input box to the right 
of the pulldown menu.  

• Language – This setting allows you to change the language of the text and phrases 
used in DroneViewer. After making a change, restart DroneViewer to see the 
change. The Default setting will attempt pick a translation based on your 
computer’s system setting. If a default translation is not available, then English 
will be used. Currently, Chinese is available and additional translations will 
follow. Be aware that newer portions of the GUI may still be in English. 

• Ignore GPS Data – Use this option to load movies without attempting to load their 
GPS data. This will allow you to quickly load movies for viewing, but will not 
show their GPS data. The message “NO GPS LOADED” will appear at the top of the 
player window when this option is invoked. To prevent use, this option is set to 
OFF each time DroneViewer is run. 

• Click-To-Go Enabled in Graphs – If this option is selected then clicking the mouse 
button in the Graph window will make DV jump to that point in the movie 
sequence (approximately). This is useful for immediately jumping to a point of 
interest in movie sequence, such as a sudden stop.  

• Invert Mouse Zoom – This checkbox inverts the direction of zoom when using the 
scroll wheel to zoom in/out of the video window. 

• Network Proxy Settings – If you connect to the internet via a proxy server, you can 
enter the server settings here. Restart DroneViewer after making changes for 
them to take effect. 

• Windows Stay On Top – This option controls whether the ancillary windows (Map, 
Dashboard, etc.) float on top of the Main Window. When the ancillary windows 
float on top of the Main window, you have more control of the window 
configuration. However on some computers (Windows Surface) this feature may 
not be advantageous. If you deselect this checkbox, the Main Window can be 
placed on top of the ancillary windows. You must restart DroneViewer to make 
this change take effect. 

• Check for Updates on Startup – If this button is checked, DroneViewer will check 
its server to see if a newer version is available. You can also invoke this option 
manually via the Help menu. 

AUTOLOAD MOVIE DIRECTORY UPON START-UP PREFERENCES: 
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• It can be useful to have DroneViewer load a specific directory of movies upon 
startup. This can be achieved by typing the movie directory in the Autoload 
Directory field. Alternatively, you can click the Use Current Directory to 
automatically input the current movie directory into the field. To enable this 
feature make sure the checkbox to the left of the field is checked. 
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MAP PREFERENCES: 

 

Map Preferences Window 

• Vehicle Marker – choose either a colored round marker or default map placemark 
for the drone’s location. 

• Marker Size – select a size for the round vehicle marker. 

• Number of Colors in Route Line – choose between 1, 5, 10 or 14 colors in the color 
scale used to indicate drone speed. A key of the colors used is shown to the right 
of the selection combo box. The scale ranges from a speed of 0 (red) to the 
maximum speed (blue, defined below) 

• Vmax Color is Based on – In the color scale, blue indicates the fastest speeds in 
the drone’s route.  You can define the speed the blue color represents, either by a 
fixed value or the maximum speed achieved for the entire journey. The fixed 
value method is useful for comparing the speeds of one journey against the 
speeds of another journey. 
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ADVANCED PREFERENCES: 

 

 
Advanced Preferences Window 

 

• Speedometer – Choose Auto to have DroneViewer scale the maximum 
speedometer value based on the videos you’ve loaded. If you want to manually 
set a maximum speedometer value, click the Speedometer Max button and enter 
the desired maximum speed. Note that the maximum speed is 200 (either mph, 
km/h, or m/s). 

• UTC Time correction – Although most drone’s store their GPS data relative to UTC 
time, some store their GPS data in local time. For those drone’s, enter the correct 
time zone offset from UTC here. This will ensure the UTC timestamp is correct 
when exporting GPS data to CSV, GPS, or KML formats. For most drones this 
preferences should be left at 0. But if your drone records GPS data in local 
time, say Pacific Standard Time, you would enter a value of -8. This setting is 
applied when exporting data to CSV, GPX, and KML files. 

• Local Time correction – Enter your timezone offset from UTC here. For example, if 
you were in the Pacific Standard Time zone you would enter a value of -8. 
DroneViewer will enter a default value based on your current timezone.  This 
value is used when exporting data to a CSV file. 
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GRAPH PREFERENCES: 

 

Graph Window settings 

The y-axis scale and number of tick marks can be controlled independently for 
each graph. By default you will have settings for the Speed, Distance, Bearing 
Graph, Altitude, and Sats-in-View Graphs. 
 
Min – choose the minimum value for the plot 
Max – choose the maximum value for the plot 
Ticks – select the number of gridlines/ticks for the plot 
 
Tip:  When a graph view is selected, the “1” and “2” keyboard keys will 
decrease/increase the Max value of the plot.  The “3” and “4” will decrease/increase 
the number of gridlines. 
Tip: You can click in a graph to jump to that point in the movie sequence. See the 
Click-To-Go Enabled in Graphs option above. 
 
Note: Settings are preserved from run to run of DroneViewer. 
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ADDITIONAL MENU OPTIONS 

CHECK FOR NEW VERSION 

 

Check for New Version window 

Check for New Version (under the Help menu) will go online to check if a newer version 
of DroneViewer is available.  If so, clicking the bottom left button will download it to 
your computer.  If you are up-to-date, the features in the current version will be shown. 
This feature can be toggled to run at program startup in the Preferences. 

The modification history for DroneViewer can be found here3. 

  

                                                
3 https://s3.amazonaws.com/aws-website-dcv-downloads-c8kwd/drv/history.pdf 
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REGISTER DRONEVIEWER 

 

Register DroneViewer to remove the 1-movie limitation 

The Register option is located under the Help menu.  After purchasing either 
DroneViewer or DroneViewer Pro from our website4, you will be sent a registration code 
which will remove the 1-movie limit.  Use Command-C to copy the code to the clipboard 
and the Paste button to enter it in the Register field. Registering will personalize 
DroneViewer and your name will appear as the registered user under the About menu: 

 

The About window displays the DroneViewer version and registration status 

SHORTCUTS 

                                                
4 http://mydroneviewer.com 
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A number of shortcuts have been added to facilitate use of the program. These include 
buttons to move forward frame-by-frame, take a screenshot, pause/resume, and more. 
Please see the list below: 

 

Shortcuts window 

PLAYER WINDOW: 

• When the Main Window is selected, the spacebar will start/stop the video player 
and the arrow keys will jump forward or reverse as indicated above. The P key will 
take a snapshot of the viewer window and save it to the Desktop. The A,S,W,D (and 
4,5,6,8) keys will translate the movie in the movie frame.  The Q and E (and 7 and 
9) keys will zoom out/in of the movie.  The 0 key resets the zoom and translation 
to default values. 

• Click the “g” key to create a Geotag at the current location. 

• Cmd-F (Mac), Ctrl-F (Win), F11, and Alt-Return (Windows) will toggle Fullscreen 
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mode. 

GRAPH WINDOW: 

• When in a graph view, the “1” and “2” keyboard keys will decrease/increase the 
Max value of the plot.  The “3” and “4” will decrease/increase the number of 
gridlines. 

• The “m”, “,”, “.”, and “/” adjust the Time Offset by -10, -1, +1, and +10 seconds, 
respectively. This is useful for graphically synchronizing the video to the cursor in 
the graphs. 

• Click anywhere in the data portion of the graph to jump to that point in the movie 
sequence. This feature can be turned off in the Preferences. 

• Click the “g” key to create a Geotag at the current location. 
 

ARRANGING WINDOWS 

DroneViewer allows you to move and resize its 5 main windows. Sometimes the windows 
can become hidden or overlap in an inconvenient way.  
 
To quickly bring all the windows back to their nominal positions, select Reset Window 
Positions from the Window menu. 

 
Options available under the Window menu. 

 
This will rearrange the program’s windows to their original configuration as shown 
below. 
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DroneViewer after Reset Window Positions was selected. 

 

To maintain relative positioning of the windows, select the Sync Window Movement 
option and all 5 windows will move together if any one of them is dragged. 
 
Use the Toggle Fullscreen option (Cmd-F) to expand the Main window to fullscreen and 
hide the ancillary windows. To return to the previous state, simply choose Cmd-F again 
(or F11 or Ctrl-F on Windows). 
 

EXPORTING GPS DATA 

Your drone’s latitude, longitude, speed, and other data for all the tracks can be 
exported to a text file.  Two file formats are supported: comma-separated value (CSV) 
and GPS Exchange format (GPX). 

EXPORTING TO CSV 

Select Export to CSV File from either the File menu or the toolbar button, give the file a 
name, and choose Save.  A CSV file will be produced from the GPS data and include the 
following fields as columns: 

• Movie filename 
• Date (Local) 
• Time (Local) 
• Date (UTC) 
• Time (UTC) 
• Latitude (Degrees) 
• Longitude (Degrees) 
• Speed (computed or from drone if available, in output units) 
• Distance (Computed from waypoints) 
• Line-Of-Sight distance from start point 
• Bearing 
• Altitude above start point 
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• Number of GPS satellites used in geolocation (if available) 

 

CSV files can be imported into Microsoft Excel, Apple Numbers, and other programs for 
further data analysis. 

Note: If the UTC date and/or time is not correct in the CSV file, you can apply an offset 
using the UTC Offset setting in the Advanced Preferences. 

EXPORTING AND USING GPX FILES 

Select Export to GPX File from either the File menu or the toolbar button, give the file a 
name, and choose Save.  DroneViewer will export the entire route as a single GPX file. 
You will also have the option to export each movie’s individual GPS data to separate GPX 
files. The files will be named based on the movie names.  

 
Click Yes to create individual GPX files for each movie segment, as well as a large GPX 
file for the entire route. Click No to create just the large GPX file for the entire route. 

 
Since DroneViewer reads GPX files too, the per-file export feature can be used to load 
the GPS data back into DroneViewer. GPX files placed inside the movie directory are 
loaded ahead of other data types like SRT, so you can use this method to ‘override’ the 
GPS data for a given movie.  This allows you to filter out bad data or insert corrected 
GPS information into DroneViewer.  
 
The GPX file format is widely supported in the commercial GPS receiver market. There 
are a number of interesting websites that can analyze your data.  One of my favorites is 
GPS Visualizer5, which has a plethora of GPS data analysis tools, maps, and plots. 
 

                                                
5 http://www.gpsvisualizer.com/ 
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Drone’s track exported to GPX file and viewed into GPS Visualizer. 

 
Another note about GPX files: Some popular activity cameras, like the GoPro Hero 4 
series, do not have a built-in GPS receiver.  However, if you are operating an external 
GPS receiver, like a Garmin eTrex or equivalent, in tandem with your activity camera you 
can export your GPS route from your receiver into GPX format. Give your GPX file the 
same base name as the activity camera movie file and make sure the two files are in the 
same directory (for example, “MyGoProMovie.MP4” and “MyGoProMovie.GPX”). When the 
movie is loaded into DroneViewer, DroneViewer will load the corresponding GPX file and 
use this as the GPS data source for the movie. If you need to make time offset 
corrections, you can do this using either the Graph shortcuts or the Preferences. 

Note: If the UTC date and/or time is not correct in the GPX file, you can apply an offset 
using the UTC Offset setting in the Advanced Preferences. 
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FAQ 

Q: I’m seeing the message “No GPS Data for this segment” on the Graph display.  What 
does it mean? 

 

 

A: The “No GPS Data” error message will be shown if DroneViewer cannot find a 
corresponding GPS log file for the currently playing movie.  If this happens the speed, 
latitude, longitude, etc, readouts will indicate 0.  It can also happen if the first movie file 
loaded has no GPS data associated with it. Try removing the first movie file from the 
folder and reloading the folder. Although infrequent, this can happen under normal 
operation. 

Q: Why don’t I see an altitude graph with the DJI Mavic 2 Pro?  

A: The SRT file produced by the DJI Mavic 2 Pro does not contain altitude data as of this 
writing. DJI will need to produce updated firmware to remedy this issue. 

Q: I have a Phantom 4 Pro V2.0 and I’ve turned on Video Captions in the Go App but SRT 
files are not created. Why?  

A: The Phantom 4 Pro v2.0 embeds the SRT data into the movie itself. DroneViewer will 
detect this and decode the data. One difference between the SRT data in a separate file 
and embedded SRT data is that the embedded SRT data is not date/time stamped. 
Therefore the file creation date is used as the start date in the case of embedded SRT 
data. 

Q: Will DroneViewer work with the Mavic Air?  

A: Unfortunately the Mavic Air does not store trajectory data in the SRT file so 
DroneViewer will not display the drone’s route. I don’t know why DJI made that decision, 
but I can’t think of any reason why the lat/lon/alt/speed couldn’t be added. Mavic Air 
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owners may want to contact DJI and request that flight log data be added to the SRT file. 
The Mavic Air 2 does store lat/lon/alt information in the SRT file, however. 

Q: Why does my route look jagged? Why does my compass appear to spin erratically 
sometimes? 

A: While it’s great that DJI and Autel log the drone’s flight data into an SRT or ASS file, 
the speed of the drone is not recorded to the file and the latitude and longitude are not 
stored in high precision (as of this writing). DroneViewer uses the time-stamped lat/lon 
values to estimate the speed. The lack of precision means the drone speed and direction 
can be inaccurate and appear to vary wildly. DroneViewer applies a smoothing function 
to dampen the speed variations. While this helps, it’s not a perfect solution. Ideally, DJI 
and Autel would modify their file data to include native drone speed and higher-
precision latitude and longitude. (There are other ways to extract the flight data to 
higher-precision but they are not as convenient as the SRT/ASS file method). [Update: 
the EVO 2 does record lat/lon to high precision but still does not record speed]. 

Q: How to I revert all of DroneViewer’s settings?  

A: Run DroneViewer with the Shift-key held down. You will be presented with the 
following dialog. 

 

Clicking ‘Yes’ will erase all the stored settings, such as window positions, window sizes, 
button settings, map settings, and preferences. These settings will revert to defaults. 
Also note that your registration code will need to be re-entered if you select this 
option. 

Q: When I merge movies nothing happens. 

A: Be sure that the file directory path to the source movies does not have quotes or 
commas in it. Also, only the registered versions of DroneViewer will merge movies. 

Q: In the movie window the player shows my drone moving but my speed is indicated as 
0 mph.   

Q: I see data plotted in the graphs but the cursor isn’t moving. 

A: Could be a couple of things. When the drone is first powered up after being off for a 
long period of time, it requires a minute or so to acquire signals from the GNSS 
satellites.  During this time the drone’s latitude, longitude, and speed are unknown and 
are displayed as “0” in DroneViewer.  
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This could also happen if the drone’s timezone is set incorrectly.  DV relies on the 
accuracy of the movie file’s timestamp to sync the movie with the GPS data. The drone’s 
timezone should be set to the computer’s timezone. If not, the difference in timezones 
should be entered in the Preferences.   

A third possibility is that the movie’s original timestamps have been altered.  This can 
happen if the files were copied from the SD card to another location.  In some cases the 
copy process itself changes the file modification date.  If this happens, use the “Auto 
Fix” button in the Preferences window to compensate for the difference in time.  To 
avoid this issue, open the original SD card’s movie folder in DV rather than opening a 
copy of the folder on a hard drive. The downside is that this may affect playback 
performance if the SD card is connected via a slow USB reader. 

Another possibility is that DV is confused by extraneous files in the movie directory. Be 
sure not to add any files to the drone movie directory (i.e., GPX files). 

Lastly, if nothing seems to fix the issue, try loading the set of movies files again but this 
time skip the first movie file. In other words, load all the movie files except the first one. 

Q: Why can’t I see all of my GPS data from my GoPro HERO5 Black’s videos? 

A: Please upgrade to Dashcam Viewer Pro to see all of your GPS data.  

Q: When I use DroneViewer to export a movie clip the quality of the video is not as good 
as I expected. Any ideas?  

DroneViewer ships with the LGPL version of FFmpeg6. The GPL version has better codecs 
for exporting video. So the solution is to replace the LGPL version of FFmpeg with the 
GPL version off the internet. You can download the Mac GPL ffmpeg here7 and the 
Windows GPL ffmpeg here8.  

Mac GPL ffmpeg installation: The Mac download comes as a DMG file. Double-click on 
the DMG file and you’ll see a disk image with a single file in it: ffmpeg. Double-click on 
ffmpeg to test run it. The first time you run it, your Mac may ask “are sure you want to 
run this program which was downloaded from the internet?”. Click “Open” and it will run 
in the Terminal and immediately quit. Now you are ready to replace the old version as 
follows: 

 

                                                
6 http://ffmpeg.org 
7 https://evermeet.cx/pub/ffmpeg/snapshots/   (get the latest .dmg file) 
8 http://ffmpeg.zeranoe.com/builds/ 
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1) Right-click on the DroneViewer icon and select Show Package Contents. This will 
open the contents in a new window. 

 

Locating ffmpeg in the Mac version of DroneViewer 

2) Open the Contents/MacOS folder. You will see the LGPL version of ffmpeg. 
Move it to a safe location outside of the package.  

3) Now move the GPL version of ffmpeg into the MacOS folder. Close the package 
window and you’re good to go! 

 
Windows GPL ffmpeg installation: Unzip the ffmpeg package and copy the ffmpeg.exe 
(located in the bin directory) to the DroneViewer directory. You will be asked if you want 
to replace the existing ffmpeg.exe. Click Yes. 
 
One caveat. Since each version of DroneViewer ships with the LGPL version, you will 
need to repeat this process every time you update DroneViewer.  

Q: The timing between the movie and the drone’s position on the map is slightly off. 
How do I fix it? 

This can happen if the drone’s clock is slightly off. To compensate for it, go to the 
Preferences and adjust the Time Bias. Then bring the Graph window to the foreground. 
Use the ‘,’ and ‘.’ keys to dynamically adjust the time cursor position until the Map 
position of the UAV and the movie match. To compensate plus or minus 10-seconds at 
a time instead of 1 second at a time, use the ‘m’ and ‘/’ keys. When the UAV’s position 
on the Map matches its position in the video, you can click the Save Settings in the 
Movie window so that when this video is played again the same adjustments will be 
applied.  

Q: [Windows version] I get an error when I run DroneViewer, “The ordinal 4369 could not 
be located in the dynamic link library LIBEAY32.dll”. What is causing it? 

This problem seems to be related to multiple versions of LIBEAY32.dll on your system. 
Please see http://superuser.com/questions/272752/intelligence-server-configuration-
and-libeay32-dll-registration-error-microstr for a solution. 

Q: [Windows] Movies appear to stutter during playback.  
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A: This occurs on some Windows PCs, usually the lower-end models or older models. 
The ideal PC system is an i7 processor running Win10 and an nVidia or AMD processor.  

Q: The Map shows me flying through a building.  What’s up with that? 

A: Could be a number of things.  For starters, obscuration of the sky by buildings and 
terrain can block line of sight to the GNSS satellites.  Fewer GNSS satellites translates to 
higher dilution of precision (DOP) and less positional accuracy at the drone.  Also, the 
GPS receivers and antennas in these cameras are commercial units are not designed for 
high accuracy.   

Q: DroneViewer is hanging on my MacBook Pro with Retina display running Yosemite (OS 
X 10.10). Any idea why? 

We have found that the Graphs display on DroneViewer has an issue with some Retina 
Macs. Try this tip from https://support.apple.com/en-us/HT202471. 

Open the DroneViewer using Low Resolution mode: 

 
1) Quit the application if it is currently open. 

2) In the Finder, choose Applications from the Go menu. 

3) In the Applications folder that opens, click the application's icon so it is highlighted. 

4) Choose Get Info from the File menu. 

5) Place a checkmark next to "Open in Low Resolution" to enable Low Resolution 
mode. 

Close the window and double click the Application to reopen it. 
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DISCLAIMER 

DroneViewer is supplied “as is” and all use is at your own risk. This document is not 
intended to express or imply any warranty that the operation of the software will be 
uninterrupted, timely, or error-free. Under no circumstances shall Earthshine Software 
be liable to any user for direct, indirect, incidental, consequential, special, or exemplary 
damages, arising from or relating to this agreement or the software.  
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